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1 Úvod 
V dnešní ekonomicky napjaté době každý přemýšlí, jak co nejvíce ušetřit na energiích. 

Technická oblast, která se tímto problémem zabývá, se nazývá řídicí nebo též regulační tech-
nika [5]. Ta říká, že pokud mají být snižovány výdaje za energie, je bezpodmínečně nutné sys-
témy správně řídit (regulovat). 

Na Vyšší odborné škole v Sezimově Ústí vznikla v roce 2011 Laboratoř aplikované in-
formatiky a fyziky [4], která byla postupem času vybavena laboratorními modely (reálnými 
technologiemi), na kterých se mohou studenti učit řídicí technice [5]. Většina těchto učebních 
pomůcek vznikla v rámci absolventských prací našich studentů [6], [1], [3], [2]. Tyto labora-
torní modely lze řídit pomocí osobních počítačů s programovým prostředím Matlab/Simulink 
s Real Time toolboxem a multifunkční kartou MF 624 od firmy Humusoft s. r. o. Tato vstupně-
výstupní karta má mimo jiné, podobně jako PLC automaty, 8 digitálních vstupů, 8 digitálních 
výstupů, 8 analogových vstupů a 8 analogových výstupů.  

V průmyslové praxi se ovšem reálné technologie řídí pomocí programovatelných auto-
matů (PLC) nikoli pomocí osobního počítače s prostředím Matlab/Simulinku. Ten se využívá 
pouze pro analýzu dané technologie a následný návrh řídicího algoritmu (u nás nejčastěji PID 
regulace) [5]. Tento navržený algoritmus se až následně naprogramuje do PLC. 

Cílem této práce bylo navrhnout a vyrobit komunikační rozhraní, které bude umožňovat 
řídit laboratorní modely pomocí PLC, konkrétně pomocí PLC od firmy AMiT. Požadavek byl, 
aby komunikační rozhraní MF 624 – PLC mělo stejný vstupní konektor jako multifunkční karta 
MF 624 tak, aby ke spojení laboratorního modelu a PLC automatu mohlo dojít pouhým odpo-
jením komunikačního vodiče z počítače a připojení tohoto vodiče do komunikačního rozhraní 
MF 624 – PLC. 

Struktura této práce je následující. Kapitola 2 specifikuje komunikační rozhraní MF 624 
– PLC z hlediska uživatele. V přílohách je uvedeno bez bližšího popisu schéma zapojení elek-
troniky, navržený plošný spoj, schéma s vrtacím otvory v plošném spoji, objednávky součástek 
a manuál k integrovanému obvodu MC33063AP1. 

2 Specifikace komunikačního rozhraní MF 624 – PLC 
Komunikační rozhraní (viz obr. 1) je připravené tak, že lze jednoduše přejít z řízení labo-

ratorního modelu pomocí osobního počítače s prostředím Matlab/Simulink s Real Time tool-
boxem a multifunkční kartou MF 624 od firmy Humusoft s. r. o. na řízení laboratorního modelu 
PLC automatem. Komunikační rozhraní je navrženo tak, že analogové vstupy a výstupy PLC 
automatu musí být v rozsahu –10 V až +10 V. Digitální vstupy a výstupy PLC automatu mají 
úrovně {0, 24}V. Na komunikačním rozhraní jsou tyto digitální signály indikovány pomocí 
LED diod s hranatými pouzdry. 

Levá část komunikačního rozhraní MF 624 – PLC obsahuje spínané zdroje 5V/500mA, 
12V/200mA a –12V/200mA. Též je zde páčkový vypínač umožňující odpojit od napájení PLC 
automat. Modrá LED dioda indikuje, že je pro PLC „připravené“ (na páčkovém vypínači) na-
pětí větší než 20V.  

Pravá část komunikačního rozhraní MF 624 – PLC obsahuje propojovací obvody mezi 
37-pinovým konektorem (stejný jako má multifunkční karta MF 624) a šroubovacími svorkov-
nicemi, ke kterým se připojuje PLC automat. Analogové výstupy PLC automatu jsou připojeny 
napřímo. Analogové vstupy PLC automatu jsou připojeny přes napěťové sledovače (integro-
vané obvody TL074IN). Digitální výstupy PLC automatu jsou připojeny přes děliče a TTL 
budiče (integrované obvody CD4050) – realizace převodu 24 V na PLC na 5 V na řízené tech-
nologii. Digitální vstupy PLC automatu jsou připojeny přes optočleny (integrované obvody 
TPL281-4) – realizace převodu 5 V na řízené technologii na 24 V na PLC. 
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obr. 1: Komunikační rozhraní MF 624 – PLC 

2.1 Napěťové sledovače na analogových vstupech PLC 

V první verzi komunikačního rozhraní byly analogové vstupy PLC automatu (respektive 
svorkovnice) připojeny napřímo. Protože vstupní odpor PLC automatu na analogových vstu-
pech je pouze 10 kΩ, docházelo ke zkreslení měřeného signálu, viz obr. 2. Proto bylo komuni-
kační rozhraní doplněno o napěťové sledovače, které mají vstupní odpor cca 1012 Ω. Tím došlo 
k impedančnímu oddělení signálů, které přicházejí ze senzorů a vstupují do analogových vstupů 
PLC automatu. Měřený signál již není zkreslován, viz obr. 3. Zde je sice ještě konstantní posun 
statické převodní charakteristiky, ale tento posun je způsoben nevhodnou elektronikou v Sys-
tému vodního hospodářství [6]. Komunikační rozhraní MF 624 – PLC bylo testováno na Sys-
tému vodní elektrárny [1], kde je jednoduchá elektronika s procesorem od firmy Atmel a zde 
již PLC automat měří zcela stejně, jako měřicí karta MF 624. 



COP: Komunikační rozhraní MF 624 – PLC 4

 

 
obr. 2: Statická převodní charakteristika senzoru výšky hladiny na Systému vodního hospodářství 

– první verze komunikačního rozhraní MF 624 – PLC 

 
obr. 3: Statická převodní charakteristika senzoru výšky hladiny na Systému vodního hospodářství 

– druhá verze komunikačního rozhraní MF 624 – PLC 
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MF 624: Voltage → Centimeters

 

 

Data
MF 624 (volts): h

c
 [cm] = 11.5073 h

c
 [V] + 4.44336

MF 624 (norm. bipolar): hc [cm] = 11.5182 ⋅ 10 ⋅ hc [-] + 4.39687

PLC (volts): hc [cm] = 14.8035 × 10 × hc [V] + 10.1301
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MF 624: Voltage on MF 624 → Centimeters

 

 

Data
MF 624: h

c
 [cm] = 10.8031 h

c
 [V] - 6.42179

TL074: hc [cm] = 10.649 × 10 × hc [V] - 2.75972

PLC: hc [cm] = 10.7452 × 10 × hc [V] - 2.30902
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Poděkování 
Autor této práce by rád poděkoval výše uvedeným spolupracovníkům, studentům a žá-

kovi za pomoc při realizaci tohoto projektu a škole za poskytnuté finanční prostředky, které 
činily 1 737 Kč. Časová náročnost projektu byla 162 hodiny. 

Několik zásad v prostředí EAGLE 

• Schematic 
o http://ucimeseeagle.cz/  
o View → Grid: Size: 100 mil 
o Edit → Add: frames - A4L-LOC (DINA4_L .. jednoduchý) 

• Board 
o View → Display/hide layers 1, 16-28, 39-43, 45, 47-52, 116 
o View → Grid: Size: 5 mm (pro okraje plošného spoje) 
o View → Grid: Size: 50 mil (pro rozmístění součástek) 
o Ruční výroba: cesta 32 (24) mil – izolace 12 mil 
o Profi výroba: cesta 16 mil – izolace 10 mil 

• Měřítka 
o    1 inch =        2.54 cm =     25.4 mm 
o     1 mil  =  0.00254 cm = 0.0254 mm 
o     5 mil  =    0.0127 cm =   0.127 mm 
o   50  mil =      0.127 cm =     1.27 mm 
o 100  mil =      0.254 cm =     2.54 mm 

Výroba modelu v čase 

• ??.04.2015 – 2,50h – J. Bumba – návrh schématu pro převodník 24V –> 5V 
• ??.04.2015 – ??h – M. Hospodářský – zadána výrobu DPS 
• 29.02.2016 – M. Hospodářský mi předal schéma v EAGLE a částečně navržený DPS 

 
• 29.02.2016 – 1,50h – kontrola schématu a nalezena chyba v záměně –12V a GND u 37-

pinnového konektoru 
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• 01.03.2016 – 1,00h – výměna pouzder u kondenzátorů a diod 
• 01.03.2016 – 3,00h – úprava schématu stabilizátorů a napájení (ochrana proti vyššímu 

napájecímu napětí a přepólování), rozmístění svorkovnic 
• 06.03.2016 – 3,00h – tvorba DPS pro DOUTs signály (budiče TTL) 
• 07.03.2016 – 2,00h – tvorba DPS (37-pinový konektor – AD, DIN) 
• 07.03.2016 – 10,0h – J. Bumba vytvořil schéma pro spínané zdroje +12V, +5V a –12V 
• 08.03.2016 – 1,00h – tvorba DPS pro DIN, DA a AD signály 
• 08.03.2016 – 0,25h – D. Doležal (VOŠ1) tvorba IO součástky v Eagle 
• 08.03.2016 – 2,50h – tvorba schématu pro spínaný zdroj +12V podle J. Bumby 
• 09.03.2016 – 2,50h – tvorba DPS pro spínaný zdroj +12V podle J. Bumby 
• 09.03.2016 – 3,00h – tvorba DPS pro indikační LED diody, posun svorkovnic na DPS 
• 10.03.2016 – 3,50h – tvorba DPS pro spínaný zdroj +12V podle J. Bumby, tvorba DPS 

pro indikační LED diody 
• 10.03.2016 – 3,00h – tvorba schématu a DPS pro spínané zdroje +5V a –12V podle 

J. Bumby 
• 11.03.2016 – 1,50h – tvorba schématu pro napájení DPS, PLC + indikace PLC, tvorba 

DPS 
• 14.03.2016 – 3,50h – tvorba DPS pro napájení a finální umístění DPS pro spínané 

zdroje 
• 15.03.2016 – 3,00h – úprava DPS pro napájení, spínané zdroje a svorkovnice dle 

komentářů J. Bumby, připojení 37-pinového konektoru 
• 15.03.2016 – 2,00h – připojení 37-pinového konektoru (pin 1 – 19 OK) 
• 16.03.2016 – 3,00h – připojení DA0–5 svorkovnic ke 37-pinovému konektoru, DINs 

připojeny přes konektor na plochý kabel 
• 17.03.2016 – 3,00h – předělání DPS pro indikační LED diody 
• 17.03.2016 – 4,00h – předělání DPS pro pro DOUTs signály (budiče TTL) – přidány 

konektory pro ploché kabely 
• 18.03.2016 – 2,50h – předělání DPS pro pro DOUTs signály (budiče TTL) – přidány 

signální LED diody 
• 18.03.2016 – 2,50h – finální úprava DPS 
• 20.03.2016 – 1,50h – finální úprava DPS pro pulsní zdroje 
• 21.03.2016 – 2,00h – výběr součástek na www.gme.cz 
• 22.03.2016 – 3,00h – pečlivá kontrola pouzder na DPS s www.gme.cz 
• 23.03.2016 – 2,00h – přidání ochranných transilů, změna polohy LED24 
• 23.03.2016 – 1,00h – přidání pájecích plošek 
• 24.03.2016 – 2,0h – finální úpravy plošného spoje (pájecí plošky k IO, rovnání cest, 

připojení canon 37) 
• 30.03.2016 – 1,50h – Martin Mikulka (ESG3) – leptání DPS 
• 01.04.2016 – 1,50h – vrtání DPS 
• 04.04.2016 – 0,50h – tisk potisku + fólie 
• 04.02.2016 – 0,25h – přišly první součástky z GME, cena 763 Kč 
• 05.04.2016 – 0,50h – nátěr DPS kalafunou (po očištění DPS Martinem Mikulkou 

(ESG3)) 
• 06.04.2016 – 0,25h – přišly zbylé součástky z GME, cena 88 Kč – chybí modrá LED 
• 07.04.2016 – 5,00h – osazení plošného spoje součástkami (propojení canon 37 

a svorkovnic) 
• 07.04.2016 – 1,50h – osazení plošného spoje součástkami (spínané zdroje) 
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• 08.04.2016 – 3,00h – první testování komunikačního rozhraní (bez spínaných zdrojů) – 
vše funguje tak, jak má 

• 14.04.2016 – 0,50h – doosazení tlumivky 220uF, Zenerovy diody, transilů a 068R 
• 14.04.2016 – 2,50h – testování DPS – zjištění chyby při měření senzorů pomocí PLC – 

chce to operační zesilovače na DPS 
• 21.04.2016 – 1,50h – P. Becker – řezání a úprava modrého panelu 
• 21.04.2016 – 1,50h – osazení modré desky (plošný spoj + PLC) 
• 21.04.2016 – 1,50h – nožičky k modré desce 
• 22.04.2016 – 1,50h – dutinky (55Kč) na napájecí vodiče (dutinky přinesl A. Fulín 

VOŠ2) 
• 22.04.2016 – 1,00h – přidán páčkový vypínač k napájecí svorkovnici PLC 
• 27.04.2016 – 1,00h – nákup dutinek (170Kč), banánků (6Kč), spojky na ethernet (25Kč) 

a modré LED (12 Kč) 
• 29.04.2016 – 1,50h – napájení modré led, přidání vypínače na PLC, výměna rezistoru 

u žluté LED 
• 03.05.2016 – 2,00h – ing. Bumba proměřil spínané zdroje +5V, +12V, –12V 
•                   103,75h 
 
• 16.04.2016 – 2,50h – úprava DPS – DI 5V → 24V 
• 17.04.2016 – 1,00h – úprava DPS – DI 5V → 24V 
• 28.04.2016 – 2,00h – úprava DPS – DI 5V → 24V (hotovo kromě indikačních LED 

a odporů) 
• 29.04.2016 – 2,00h – úprava DPS – DI 5V → 24V – indikačních LED 3-7 a odpory 
• 30.04.2016 – 2,50h – úprava DPS – DI 5V → 24V – všechny indikační LED a odpory – 

malý posun zdrojů 
• 01.05.2016 – 1,00h – úprava DPS – DI 5V → 24V – napájení optočlenů +24V 
• 02.05.2016 – 0,50h – konzultace u ing. Bumby ohledně rezistorů k optronům 
• 04.05.2016 – 2,00h – zkouška optronů s LED přímo do PLC – funguje + úprave DPS 
• 04.05.2016 – 1,50h – předělání DPS pro DOUTs signály (budiče TTL) – propojky pod 

patici 
• 05.05.2016 – 1,50h – úprava DPS – napěťové sledovače na ADs 
• 08.05.2016 – 1,00h – úprava DPS – napěťové sledovače na ADs 
• 10.05.2016 – 0,50h – Martin Mikulka (ESG3) – pomoc s napěťovými sledovači 
• 10.05.2016 – 1,50h – úprava DPS – posun 37-pinového konektoru vlevo 
• 11.05.2016 – 2,50h – výkres střední lišty v AutoCADu (MF624-

PLC_lišta_střední_horní, MF624-PLC_lišta_střední_dolní) + 
gravírování na laser (+ Lukáš Sedlák VOŠ1 1h) 

• 12.05.2016 – 0,50h – montáž střední lišty na panel 
• 12.05.2016 – 0,50h – Lukáš Sedlák (VOŠ1) – výkres dolní lišty v AutoCADu (MF624-

PLC_lišta_dolní_horní)  
• 12.05.2016 – 0,25h – Lukáš Sebera, Dominik Doležal (VOŠ1) – uříznutí lišty na 45° 
• 12.05.2016 – 0,25h – gravírování dolní lišty na laser 
• 12.05.2016 – 3,00h – úprava DPS – napěťové sledovače na AD4 – AD7 
• 13.05.2016 – 0,50h – úprava DPS – posun svorkovnic ADs dolů 
• 14.05.2016 – 1,50h – úprava DPS – posun 37-pinového konektoru nahoru a obvodů 

DOUTs vlevo a nahoru 
• 14.05.2016 – 3,50h – úprava DPS – napěťové sledovače komplet – chybí jen napájení 

IO 
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• 16.05.2016 – 2,00h – úprava DPS – napěťové sledovače komplet – posun vedle sebe 
• 17.05.2016 – 1,00h – úprava DPS – zem k napěťovým sledovačům 
• 19.05.2016 – 1,00h – úprava DPS – posun zdrojů nahoru 
• 24.05.2016 – 2,00h – úprava DPS – napájení napěťových sledovačů 
• 24.05.2016 – 3,00h – úprava DPS – posun 37-pinového konektoru a 10-pinnového 

konektoru vpravo 
• 25.05.2016 – 1,00h – příprava pro tisk DPS 
• 25.05.2016 – 0,25h – Martin Mikulka (ESG3) – osvícení plošného spoje 
• 26.05.2016 – 1,50h – Dominik Doležal (VOŠ1) – vyndání součástek z první verze DPS 

(kromě zdroje 5V) 
• 26.05.2016 – 1,00h – Martin Mikulka (ESG3) – leptání a vrtání DPS 
• 26.05.2016 – 1,00h – výběr součástek na www.gme.cz (páčkový vypínač 62 Kč z C110) 
• 27.05.2016 – 0,50h – převrtání otvorů na modré desce 
• 27.05.2016 – 0,50h – Dominik Doležal (VOŠ1) – zastřižení DPS (na praxi) 
• 30.05.2016 – 3,00h – osazení plošného spoje součástkami (kromě zdroje 5V a nových 

obvodů) 
• 31.05.2016 – 1,00h – osazení plošného spoje součástkami (patice pro TTL budiče + 

propojky) 
• 31.05.2016 – 0,50h – montáž boční lišty na panel 
• 31.05.2016 – 0,25h – Dominik Doležal (VOŠ1) – vyndání součástek z první verze DPS 

(zdroj 5V) 
• 01.06.2016 – 0,50h – osazení plošného spoje součástkami (zdroj 5V) 
• 02.06.2016 – 0,25h – přišly první součástky z GME, cena 75 Kč 
• 02.06.2016 – 0,25h – osazení plošného spoje součástkami (rezistory 100kOhm) 
• 06.06.2016 – 0,00h – přišly zbylé součástky z GME, cena 584 Kč 
• 06.06.2016 – 1,50h – osazení plošného spoje součástkami (DINs, DOUTs LED, 

operační zesilovače) 
• 06.06.2016 – 0,50h – oživení desky 
• 07.06.2016 – 1,00h – testování desky 100kOhm rezistory na ADs chce vyměnit za 

10MOhm 
• 09.06.2016 – 2,75h – testování desky s operačními zesilovači TL074IN 



Analog system outputs (sensors)
Analog

system inputs
(actuators)

Digital system outputs (sensors)

Analog system inputs

(actuators)

Digital system inputs (actuators)

A
D

0

A
D

1

A
D

2

A
D

3

A
D

4

A
D

5

A
D

6

A
D

7

D
A

6

D
A

7

D
IN

0

D
IN

1

D
IN

2

D
IN

3

D
IN

4

D
IN

5

D
IN

6

D
IN

7

D
A

0

D
A

1

D
A

2

D
A

3

D
A

4

D
A

5

-1
2V

+
12

V

+
5V

G
N

D

D
O

0

D
O

1

D
O

2

D
O

3

D
O

4

D
O

5

D
O

6

D
O

7

A
G

N
D

M
od

el
 D

IN
pu

ts
 (

5 
V

)
P

LC
 D

O
U

Ts
 (

24
 V

)

A
G

N
D

A
G

N
D

A
G

N
D

C
A

N
O

N
 3

7F

-1
2V

+1
2V

+5
V

0R0R0R

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

X
19

-1

X
19

-2

X
20

-1

X
20

-2

X
21

-1

X
21

-2

X
22

-1

X
22

-2

X
7-

1

X
7-

2

X
8-

1

X
8-

2

X
9-

1

X
9-

2

X
10

-1

X
10

-2

X
11

-1

X
11

-2

X
3-

1

X
3-

2

1
20

2
21

3
22

4
23

5
24

6
25

7
26

8
27

9
28

10
29

11
30

12
31

13
32

14
33

15
34

16
35

17
36

18
37

19

X
24

X
4-

1

X
4-

2

X
5-

1

X
5-

2

X
6-

1

X
6-

2

X
17

-1

X
17

-2

X
16

-1

X
16

-2

X
12

-1

X
12

-2

X
13

-1

X
13

-2

X
14

-1

X
14

-2

X
15

-1

X
15

-2

X
18

-1

X
18

-2

R
0

R
05

R
01

2 

X
26

-3

X
26

-5

X
26

-7

X
26

-9

X
25

-4

X
25

-6

X
25

-8

X
25

-1
0

A
D

0-
1/

4.
2A

A
D

1-
1/

4.
2B

A
D

2-
1/

4.
2C

A
D

3-
1/

4.
2C

A
D

4-
1/

4.
3A

A
D

5-
0/

4.
2B

A
D

6-
0/

4.
2B

A
D

7-
0/

4.
2C

D
O

0-
1/

2.
1A

D
O

1-
1/

2.
1B

D
O

2-
1/

2.
1B

D
O

3-
1/

2.
1C

D
O

4-
1/

2.
2A

D
O

5-
1/

2.
2B

D
O

6-
1/

2.
2B

D
O

7-
1/

2.
2C

D
I4

-0
/3

.3
A

D
I7

-0
/3

.3
C

D
I6

-0
/3

.3
B

D
I5

-0
/3

.3
B

D
I3

-0
/3

.1
C

D
I2

-0
/3

.1
B

D
I1

-0
/3

.1
B

D
I0

-0
/3

.1
A

LE
D

5/
5.

4A

LE
D

12
/5

.4
C

D
I4

-1
/3

.4
A

D
I5

-1
/3

.4
B

D
I6

-1
/3

.4
C

D
I7

-1
/3

.4
C

D
I3

-1
/3

.2
C

D
I2

-1
/3

.2
C

D
I1

-1
/3

.2
B

D
I0

-1
/3

.2
A

A
D

0-
0/

4.
1A

A
D

1-
0/

4.
1B

A
D

2-
0/

4.
1B

A
D

3-
0/

4.
1C

A
D

4-
0/

4.
2A

A
D

5-
1/

4.
3B

A
D

6-
1/

4.
3C

A
D

7-
1/

4.
3C

37
pi

n 
co

nn
ec

to
r 

an
d 

te
rm

in
. b

lo
ck

s

C
on

ve
rt

er
  M

F
 6

24
 -

 P
LC

1K
 8

22
 6

81

D
A

T
U

M
:

LI
S

T:

K
O

N
S

T
R

U
K

C
N

Í C
E

LE
K

S
O

U
B

O
R

:

N
áz

ev
:

JK
O

 k
ód

:

F
U

N
K

C
N

Í J
E

D
N

O
T

K
A

N
áz

ev
:

JK
O

 k
ód

:

I



B
lo

ck
in

g 
ca

pa
ci

to
r 

an
d 

su
pp

ly
 o

f I
O

1,
 IO

2

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

C
D

40
50

B
E

3k
9 68

0R

3k
9 68

0R

3k
9 68

0R

3k
9 68

0R

3k
9 68

0R

3k
9 68

0R

3k
9 68

0R

3k
9 68

0R

10
0n

/5
0V

10
0n

/5
0V

+5
V

R
E

D

3k
9

R
E

D

R
E

D

R
E

D

3k
9

3k
9

3k
9

R
E

D

3k
9

R
E

D

3k
9

3k
9

3k
9

R
E

D

R
E

D

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

M
LW

10
G

3
2

IO
1A

5
4

IO
1B

7
6

IO
1C

9
10

IO
1D

11
12

IO
1E

14
15

IO
1F

81

3
2

IO
2A

5
4

IO
2B

7
6

IO
2C

9
10

IO
2D

11
12

IO
2E

14
15

IO
2F

81

R
0A

R
0B

R
1A

R
1B

R
2A

R
2B

R
3A

R
3B

R
4A

R
4B

R
5A

R
5B

R
6A

R
6B

R
7A

R
7B

C
2

C
1

LE
D

O
0

R
O

0

LE
D

O
1

LE
D

O
2

LE
D

O
3

R
O

1

R
O

2

R
O

3

LE
D

O
4

R
O

4

LE
D

O
5

R
O

5

R
O

6

R
O

7

LE
D

O
6

LE
D

O
7

X
26

-4

X
26

-6

X
26

-8

X
26

-1
0

X
25

-3

X
25

-5

X
25

-7

X
25

-9
D

O
3-

1/
1.

4C

D
O

2-
1/

1.
4C

D
O

1-
1/

1.
4C

D
O

0-
1/

1.
4B

D
O

4-
1/

1.
4C

D
O

5-
1/

1.
4C

D
O

6-
1/

1.
4C

D
O

7-
1/

1.
4D

8-
bi

t c
on

ve
rt

er
 2

4 
V

 -
->

 5
 V

1F
 8

22
 6

81

C
on

ve
rt

er
  M

F
 6

24
 -

 P
LC

1K
 8

22
 6

81

IO
1:

 R
em

ov
e 

pi
n 

6 
an

d 
13

IO
2:

 R
em

ov
e 

pi
n 

 6
 a

nd
 1

3

X
26

: R
em

ov
e 

pi
n 

1 
an

d 
2

X
25

: R
em

ov
e 

pi
n 

1 
an

d 
2

D
A

T
U

M
:

LI
S

T:

K
O

N
S

T
R

U
K

C
N

Í C
E

LE
K

S
O

U
B

O
R

:

N
áz

ev
:

JK
O

 k
ód

:

F
U

N
K

C
N

Í J
E

D
N

O
T

K
A

N
áz

ev
:

JK
O

 k
ód

:

1> (1
) 1> (2
)

1> (3
)

1> (4
)1> (5
)

1> (6
)

1> (1
) 1> (2
)

1> (3
)

1> (4
)1> (5
)

1> (6
)



T
LP

28
1-

4

T
LP

28
1-

4

T
LP

28
1-

4

T
LP

28
1-

4

47
0R

O
R

A
N

G
E

47
0R

O
R

A
N

G
E

47
0R

O
R

A
N

G
E

47
0R

O
R

A
N

G
E

T
LP

28
1-

4

T
LP

28
1-

4

T
LP

28
1-

4

T
LP

28
1-

4

47
0R

O
R

A
N

G
E

47
0R

O
R

A
N

G
E

47
0R

O
R

A
N

G
E

47
0R

O
R

A
N

G
E

1 2
1516

O
K

2A

3 4
1314

O
K

2B

5 6
1112

O
K

2C

7 8
910

O
K

2D
R

I7

LE
D

I7

R
I6

LE
D

I6

R
I5

LE
D

I5

R
I4

LE
D

I4

1 2
1516

O
K

1A

3 4
1314

O
K

1B

5 6
1112

O
K

1C

7 8
910

O
K

1D
R

I3

LE
D

I3

R
I2

LE
D

I2

R
I1

LE
D

I1

R
I0

LE
D

I0

D
I6

-1
/1

.1
C

D
I5

-1
/1

.1
C

D
I4

-1
/1

.1
C

D
I4

-0
/1

.2
C

D
I5

-0
/1

.2
C

D
I6

-0
/1

.2
C

D
I7

-0
/1

.2
D

D
I0

-1
/1

.1
B

D
I0

-0
/1

.2
B

D
I1

-0
/1

.2
C

D
I1

-1
/1

.1
C

D
I2

-0
/1

.2
C

D
I2

-1
/1

.1
C

D
I3

-1
/1

.1
C

D
I3

-0
/1

.2
C

24
V

/5
.2

A

24
V

/5
.2

A

24
V

/5
.2

A

24
V

/5
.2

A

24
V

/5
.2

A

24
V

/5
.2

A

24
V

/5
.2

A

24
V

/5
.2

A

D
I7

-1
/1

.1
D

C
on

ve
rt

er
  M

F
 6

24
 -

 P
LC

8-
bi

t c
on

ve
rt

er
 5

 V
 -

->
 2

4 
V

D
A

T
U

M
:

LI
S

T:

K
O

N
S

T
R

U
K

C
N

Í C
E

LE
K

S
O

U
B

O
R

:

N
áz

ev
:

JK
O

 k
ód

:

F
U

N
K

C
N

Í J
E

D
N

O
T

K
A

N
áz

ev
:

JK
O

 k
ód

:



B
lo

ck
in

g 
ca

pa
ci

to
r 

an
d 

su
pp

ly
 o

f I
C

1,
 IC

2

T
L0

74
IN

T
L0

74
IN

T
L0

74
IN

T
L0

74
IN

-1
2V

+1
2V

10
0n

/5
0V

10
0n

/5
0V

T
L0

74
IN

T
L0

74
IN

T
L0

74
IN

T
L0

74
IN

10
M

10
M

10
M

10
M

10
0n

/5
0V

10
0n

/5
0V

10
M

10
M

10
M

10
M

0R

0R0R

23
1

IC
1A

65
7

IC
1B

910
8

IC
1C

1312
14

IC
1D

4 11

C
3

C
4

23
1

IC
2A

65
7

IC
2B

910
8

IC
2C

1312
14

IC
2D

4 11

R
A

4

R
A

5

R
A

6

R
A

7

C
5

C
6

R
A

0

R
A

1

R
A

2

R
A

3

R
0G

N
D

R
01

2N

R
01

2

A
D

0-
0/

1.
2A

A
D

1-
0/

1.
2A

A
D

2-
0/

1.
2A

A
D

3-
0/

1.
2A

A
D

0-
1/

1.
1A

A
D

1-
1/

1.
1A

A
D

2-
1/

1.
1A

A
D

3-
1/

1.
1A

A
D

4-
0/

1.
2A

A
D

5-
0/

1.
2B

A
D

6-
0/

1.
2B

A
D

7-
0/

1.
2B

A
D

7-
1/

1.
1B

A
D

6-
1/

1.
1B

A
D

5-
1/

1.
1B

A
D

4-
1/

1.
1A

C
on

ve
rt

er
  M

F
 6

24
 -

 P
LC

8-
 v

ol
ta

ge
 fo

llo
w

er
s

D
A

T
U

M
:

LI
S

T:

K
O

N
S

T
R

U
K

C
N

Í C
E

LE
K

S
O

U
B

O
R

:

N
áz

ev
:

JK
O

 k
ód

:

F
U

N
K

C
N

Í J
E

D
N

O
T

K
A

N
áz

ev
:

JK
O

 k
ód

:



F
ilt

er

F
ilt

er

F
ilt

erP
LC

S
up

pl
y

E
xt

er
na

l
V

ol
ta

ge
S

up
pl

y

+
12

 V
/m

ax
. 2

00
 m

A

(0
,5

A
)

(E
S

R
)

(E
S

R
)

(E
S

R
)

(0
,5

A
)

+
5 

V
/m

ax
. 5

00
 m

A

(1
A

)

(E
S

R
)

(E
S

R
)

(E
S

R
)

(1
A

)

-1
2 

V
/m

ax
. 2

00
 m

A

(0
,5

A
)

(E
S

R
)

(0
,5

A
)

(E
S

R
)

(E
S

R
)

G
N

D

+
24

V
+

20
 -

 2
8V

G
N

D

C
N

12
5?

10
00

uF
/3

5V

M
C

33
06

3A
P

1G

10
0u

F
/5

0V
82

0p
F

/5
0V

0,
68

R

10
k3

2

1k
2

22
0u

F
/3

5V

3k
9

+1
2V

/Y
E

LL
O

W

56
0u

H

3,
3u

H 10
0u

F
/5

0V

+1
2V

M
C

33
06

3A
P

1G

10
0u

F
/5

0V
33

0p
F

/5
0V

0,
33

R

3k
9

1k
2

47
0u

F
/3

5V

68
0R

+5
V

/R
E

D

1N
58

19
22

0u
H

3,
3u

H 10
0u

F
/5

0V

+5
V

1k
5-1

2V
/G

R
E

E
N

3,
3u

H 10
0u

F
/5

0V

-1
2V

1N
58

19

M
C

33
06

3A
P

1G

10
0u

F
/5

0V
47

0p
F

/5
0V

0,
47

R

10
k3

2
1k

2

22
0u

F
/3

5V1N
58

19
56

0u
H

+2
4V

S
B

26
0

+2
4V

B
Z

X
83

V
01

8

+2
4V

/B
LU

E

2k
7

S
B

26
0

1A
2A B
Z

W
06

-2
6

B
Z

W
06

-2
6

IPK7

DC8

SWC1

GND 4

TC 3

CII 5

S
W

E
2

V
C

C
6

IO
12

C
12

1
C

12
2

R
12

3

R
12

2

R
12

1

C
12

3

R
12

4

LE
D

12

L1
21

L1
22

C
12

4

IPK7

DC8

SWC1

GND 4

TC 3

CII 5

S
W

E
2

V
C

C
6

IO
5

C
51

C
52

R
53

R
52

R
51

C
53

R
54LE

D
5

D
5

L5
1

L5
2

C
54

R
N

12
4

LE
D

N
12

LN
12

2

C
N

12
4

D
12

IPK7

DC8

SWC1

GND 4

TC 3

CII 5

S
W

E
2

V
C

C
6

IO
N

12

C
N

12
1

C
N

12
2

R
N

12
3

R
N

12
2

R
N

12
1

C
N

12
3D

N
12

LN
12

1

D
1

X
2-

1

X
2-

2

D
24

LE
D

24

R
24

D
2

X
1-

1

X
1-

2

F
1

F
2

D
T

2
D

T
1

S
1

2
31

24
V

/3
.4

A

LE
D

5/
1.

3B

LE
D

12
/1

.3
B

+
-1

2 
V

 /2
00

 m
A

, +
5 

V
/2

00
 m

A
1F

 0
21

 0
43

C
on

ve
rt

er
  M

F
 6

24
 -

 P
LC

1K
 8

22
 6

81

D
A

T
U

M
:

LI
S

T:

K
O

N
S

T
R

U
K

C
N

Í C
E

LE
K

S
O

U
B

O
R

:

N
áz

ev
:

JK
O

 k
ód

:

F
U

N
K

C
N

Í J
E

D
N

O
T

K
A

N
áz

ev
:

JK
O

 k
ód

:

+

+

+

+

+

+

+

+

+



 

 

 

 



Koupit1Rychlé vložení do košíku dle kódu

Obrázek Kód Název Dostupnost Cena bez DPHCena za položku s DPH

070-409 DIN lišta PR-TS 35 0,3M Ano 32,2314 Kč 39,00 Kč

661-061 Fotocuprextit FR4 200x150x1,5 jednovrstvý Ano 126,4463 Kč 153,00 Kč

623-151 Distanční sloupek DI5M3X10 nikl VIGAN Ano 24,8521 Kč 30,07 Kč

623-162 Distanční sloupek DA5M3X05 nikl VIGAN Ano 30,0843 Kč 36,40 Kč

623-149 Distanční sloupek DI5M3X05 nikl VIGAN Ano 22,8901 Kč 27,70 Kč

120-094 CK 100n/50V X7R RM5,08 10% HITANO Ammo Ano 4,2975 Kč 5,20 Kč

120-132 CK 330p/50V Y5P RM5,08 10% Ano 1,0744 Kč 1,30 Kč

123-732 CE 470u/35VIT HIT-ESX 10x20 RM5 BULK Ano 5,6198 Kč 6,80 Kč

120-150 CK 820p/50V Y5P RM5,08 10% Ano 1,0744 Kč 1,30 Kč

123-443 CE 100u/50VIT CAP-GL 8x16 RM3,5 Ano 49,5868 Kč 60,00 Kč

120-140 CK 470p/50V Y5P RM5,08 10% Ano 1,9008 Kč 2,30 Kč

123-404 CE 220u/35VIT HIT-EXR 10x16 RM5 BULK Ano 6,1157 Kč 7,40 Kč

223-116 Dioda SB260 Ano 3,8017 Kč 4,60 Kč

222-031 Zenerova dioda BZX83V018 Ano 2,9752 Kč 3,60 Kč

223-001 Dioda 1N5819 Ano 6,1983 Kč 7,50 Kč

222-004 Transil Unipolární BZW06-26 30V Ne 21,1570 Kč 25,60 Kč

633-017 Pojistka trubičková F 1A 5x20 Ano 12,2314 Kč 14,80 Kč

633-165 Pojistka trubičková F 2,5A 5x20 Ano 12,2314 Kč 14,80 Kč

829-032 Pojistkové pouzdro do DPS SCHURTER 0031.8201 Ano 21,4876 Kč 26,00 Kč

427-059 CMOS 4050 DIP16 TEXAS INSTRUMENTS Ano 22,8099 Kč 27,60 Kč

824-004 DIL16PZ Ano 15,7025 Kč 19,00 Kč

433-252 MC33063AP1 DIP8 ON SEMICONDUCTOR Ano 59,5041 Kč 72,00 Kč

824-002 DIL08PZ Ano 19,5868 Kč 23,70 Kč

511-141 LED 3MM RED 45/60° HLMP-K101 Ne 1,6529 Kč 2,00 Kč

511-280 LED OBD.ORANGE 40/125° BL-RJE1V2N 20 / 2016 10,5785 Kč 12,80 Kč

511-466 LED 3MM YELLOW 1,5/60° L-934LYD Ano 2,2314 Kč 2,70 Kč

511-985 LED 5MM BLUE 90/60° L-53MBDL Ne 13,2232 Kč 16,00 Kč

511-724 LED 3MM GREEN 32/60° L-934GD Ano 2,0661 Kč 2,50 Kč

611-017 Tlumivka axiální TL 220uH SMCC FASTRON Ano 8,2645 Kč 10,00 Kč

611-170 Tlumivka radiální 09P-561K MATSUTA Ano 19,8347 Kč 24,00 Kč
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Zpět do obchodu Přejít k pokladněPřepočítat košíkVerze pro tisk

Převod košíku Vyberte pobočku

Copyright 1990–2016 GM electronic, spol. s r. o.

611-005 Tlumivka axiální TL 1uH SMCC FASTRON 20 / 2016 24,7934 Kč 30,00 Kč

110-085 RM 3k9 0207 0,6W 1% Ano 17,1901 Kč 20,80 Kč

119-145 RD 0R 0207 0,6W Ano 3,2231 Kč 3,90 Kč

110-069 RM 680R 0207 0,6W 1% Ano 19,3388 Kč 23,40 Kč

110-086 RM 3k6 0207 0,6W 1% 14 / 2016 2,1488 Kč 2,60 Kč

110-369 RM 0R33 0207 0,6W 5% HITANO Ano 1,0744 Kč 1,30 Kč

119-158 RM 560R 0204 0,4W 1% YAGEO Ano 1,8182 Kč 2,20 Kč

114-507 RMO 0R68 0411 2W 5% Ano 3,2231 Kč 3,90 Kč

119-091 RM 3k9 0204 0,4W 1% YAGEO Ano 14,5455 Kč 17,60 Kč

110-075 RM 1K2 0207 0,6W 1% Ano 6,4463 Kč 7,80 Kč

110-097 RM 10k 0207 0,6W 1% Ano 4,2975 Kč 5,20 Kč

110-370 RM 0R47 0207 0,6W 5% HITANO Ano 1,0744 Kč 1,30 Kč

119-406 RM 1k5 0204 0,4W 1% HITANO Ano 3,1405 Kč 3,80 Kč

821-048 Svorkovnice šroubovací do DPS ARK500/2EX Ano 3,5537 Kč 4,30 Kč

821-083 Svorkovnice šroubovací do DPS ARK210/2EX Ano 55,5218 Kč 67,18 Kč

801-030 Konektor CAN 37 Z P Ano 15,7025 Kč 19,00 Kč

800-035 Konektor MLW10G Ano 14,8760 Kč 18,00 Kč

800-007 Konektor PFL10 Ano 17,5207 Kč 21,20 Kč

Celková cena dostupných položek 712,1912 Kč 862,00 Kč

Nedostupné položky jsou řešeny v kroku 4.
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Převod košíku Vyberte pobočku

Copyright 1990–2016 GM electronic, spol. s r. o.

Obrázek Kód Název Dostupnost Cena bez DPHCena za položku s DPH

801-031 Konektor CAN 37 Z S Ano 36,3636 Kč 44,00 Kč

801-027 Konektor CAN 37 V S Ano 36,3636 Kč 44,00 Kč

661-061 Fotocuprextit FR4 200x150x1,5 jednovrstvý Ano 126,4463 Kč 153,00 Kč

120-094 CK 100n/50V X7R RM5,08 10% HITANO Ammo Ano 8,5950 Kč 10,40 Kč

311-043 TL074IN DIP14 STM/THOMSON Ano 37,1901 Kč 45,00 Kč

824-003 DIL14PZ Ano 13,5537 Kč 16,40 Kč

511-380 LED OBD,RED 80/110° L-113SRDT Ano 23,1405 Kč 28,00 Kč

961-022 TLP281-4 SO16 TOSHIBA Ano 84,2975 Kč 102,00 Kč

119-145 RD 0R 0207 0,6W Ano 3,2231 Kč 3,90 Kč

114-467 RM 2k7 0309 1W 1% Ano 1,5702 Kč 1,90 Kč

119-142 RM 680R 0204 0,4W 1% YAGEO Ano 1,8182 Kč 2,20 Kč

119-091 RM 3k9 0204 0,4W 1% YAGEO Ano 1,8182 Kč 2,20 Kč

119-018 RM 1M 0204 0,4W 1% YAGEO Ano 14,5455 Kč 17,60 Kč

119-131 RM 470R 0204 0,4W 1% YAGEO Ano 14,5455 Kč 17,60 Kč

Celková cena dostupných položek 403,4810 K č 488,00 Kč

Nedostupné položky jsou řešeny v kroku 4.
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160 000 výrobků v nabídce
3000 každodenně balíků
132 000 zákazníků ze 128 zemí

Váš účet Nabídky Symboly zákazníka Proforma faktury Historie prodeje Parkoviště Aplikace Informování QuickBuy Porovnávač

OBJEDNÁVKY
ON-LINE

KATALOG
ON-LINE OBJEDNEJ KATALOG

O FIRMĚ
O výrobcích

Výrobek týdne

Obchodní podmínky

Práce (2 nová nabídka)

Ke stažení

Politika ohledně cookies

Údaje o životním prostředí

JAK NAKOUPIT
Způsob a poplatky za dopravu

Způsob objednávání

Ceny

Formy úhrady

Prodejní dokumenty

Čas dodání

Reklamační procedura

OBCHODNÍ ZASTUPITELSTVÍ
TME Czech Republic S.R.O.

TME Hungary Kft.

Transfer Multisort Elektronik s.r.l.

TME SLOVAKIA S.R.O.

TME Germany GmbH

Transfer Multisort Elektronik S.L.U.

Transfer Multisort Elektronik B.V.

VÁŠ ÚČET
Nabídky

Symboly zákazníka

Faktury

Historie prodeje

Parkoviště

Jsi správně přihlášený cop_c227  ( 2232731 )

HLEDEJ PRODUKT

vyhledávání výrobků v 23 jazycích

Váš účet Nabídky Symboly zákazníka Proforma faktury Historie prodeje Parkoviště Soubory Aplikace Informování QuickBuy

PANEL

* Všechny ceny jsou uvedené bez DPH a neobsahují náklady na dopravu, které se dopočtou do objednávky jako samostatná položka. Hodnotu nákladů na dopravu najdete zde: "Jak
nakoupit".

NEWSLETTER TME

Informace o událostech, akcích a nových výrobcích přímo
do Vaší schránky.

?

Podmínky
Ukončit odebírání newsletteru

symbol zboží objednané množství

QUICK BUY ?

Další volby Quick Buy

VÍTEJTE V TME CZECH REPUBLIC S.R.O.HLAVNÍ STRANA JAK NAKOUPIT NÁPOVĚDA O FIRMĚ KONTAKT

?

Nálepka Nabídka Množství
Stav

skladu Informování
Cena netto

*
Hodnota netto

*
%

DPH

COIL0912-0.22

Tlumivka: vinutá; 220uH; 1,4A; 355mΩ; THT; ±10%; svislý;
Rozteč:5mm
Výrobce:  FERROCORE
Označení výrobce:  COIL0912-0.22

2
 ks

Dodávky do skladu

-  - - -

M0.6W-0R68

Rezistor: metal film; THT; 680mΩ; 0,6W; ±5%; Ø2,5x6,8mm;
200ppm/°C
Výrobce:  ROYAL OHM
Označení výrobce:  MF006JJ068KA50

10
 ks

Dodávky do skladu

-  - - -

Hodnota složky netto: Kliknout pro stanovení hodnoty

Seznam složek  / MF 624 - PLC (2)
Datum vytvoření: 2016-04-04 / Datum změny: 2016-04-04

LINECARD

Produkty uvidíte, až vyberete výrobce nebo kategorii

všechny kategorie

všichni výrobci

Tato stránka používá soubory cookie. Pokud se chcete dozvědět více o souborech cookie a možnostech jejich nastavení, klikněte zde.Zpětná vazba

TME Czech Republic s.r.o. - Elektronické součástky https://www.tme.eu/cz/Profile/Parking/746458.html
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160 000 výrobků v nabídce
3000 každodenně balíků
132 000 zákazníků ze 128 zemí

Váš účet Nabídky Symboly zákazníka Proforma faktury Historie prodeje Parkoviště Aplikace Informování QuickBuy Porovnávač

OBJEDNÁVKY
ON-LINE

KATALOG
ON-LINE OBJEDNEJ KATALOG

O FIRMĚ
O výrobcích
Výrobek týdne
Obchodní podmínky
Politika ochrany osobních údajů
Práce (2 nová nabídka)
Ke stažení
Politika ohledně cookies
Údaje o životním prostředí

JAK NAKOUPIT
Způsob a poplatky za dopravu
Způsob objednávání
Ceny
Formy úhrady
Prodejní dokumenty
Čas dodání
Reklamační procedura

OBCHODNÍ ZASTUPITELSTVÍ
TME Czech Republic S.R.O.
TME Hungary Kft.
Transfer Multisort Elektronik s.r.l.
TME SLOVAKIA S.R.O.
TME Germany GmbH
Transfer Multisort Elektronik S.L.U.
Transfer Multisort Elektronik B.V.
TME ITALIA S.R.L.

VÁŠ ÚČET
Nabídky
Symboly zákazníka
Faktury
Historie prodeje
Parkoviště

Jsi správně přihlášený COP_C227 ( 2232731 )

HLEDEJ PRODUKT

vyhledávání výrobků v 23 jazycích

Váš účet Nabídky Symboly zákazníka Proforma faktury Historie prodeje Parkoviště Soubory Aplikace Informování QuickBuy

PANEL

* Všechny ceny jsou uvedené bez DPH a neobsahují náklady na dopravu, které se dopočtou do objednávky jako samostatná položka. Hodnotu nákladů na dopravu najdete zde: "Jak
nakoupit".

NEWSLETTER TME

Informace o událostech, akcích a nových výrobcích přímo
do Vaší schránky.

?

Podmínky
Ukončit odebírání newsletteru

symbol zboží objednané množství

QUICK BUY ?

Další volby Quick Buy

VÍTEJTE V TME CZECH REPUBLIC S.R.O.HLAVNÍ STRANA JAK NAKOUPIT NÁPOVĚDA O FIRMĚ KONTAKT

?

Nálepka Nabídka Množství Stav
skladu Informování

Cena netto
*

Hodnota netto
*

%
DPH

IC1101T2B4M6QE
Přepínač: páčkový; 2 polohy; SPDT; ON-ON; 5A/125VAC;
5A/28VDC
Výrobce: IC SWITCHES
Označení výrobce: IC1101T2B4M6QE

1  ks

Dodávky do skladu
- � - - -

Hodnota složky netto: Kliknout pro stanovení hodnoty

� � � �Seznam složek / aaa (1)
Datum vytvoření: 2016-05-26 / Datum změny: 2016-05-26

LINECARD

Produkty uvidíte, až vyberete výrobce nebo kategorii

všechny kategorie

všichni výrobci

a používá soubory cookie. Pokud se chcete dozvědět více o souborech cookie a možnostech jejich nastavení, klikněte zde.Zpětná vazba

TME Czech Republic s.r.o. - Elektronické součástky https://www.tme.eu/cz/Profile/Parking/781850.html
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